
User manual  

Version 9.0.X, September 2021  

 

 

  

NXPowerLite for File
Servers

 

   

 

 

 

 

 

 

 

 

 

 

  

neuxpower.com Simple Storage Reduction Software
 

http://www.neuxpower.com/


Table of Contents

. Table of Contents 1

. Reference 2

. Adding Folders 3-5

. Files to include 6-7

. Settings 8-10

. Preferences 11

. Scheduling 12

. Registration 13

. Reports 14-16

. Support 17

. System Requirements 18

. Configuring the NXPowerLite service 19-20

. Legal Notices 21-22

 NXPowerLite for File Servers Help

1 NXPowerLite for File Servers Help



Reference

NXPowerLite for File Servers Help  

2 NXPowerLite for File Servers Help



Adding Folders

Add a folder

To configure the drives and folders that are to be processed click on the 'Add folder...'
button on the Dashboard and select the folder or drive to include from the folder
browser. By default, these folders will be added to the list with Default profiles for
both Files to include and Settings.

To configure a custom profile, please select the 'New profile..' option in the relevant
drop-down controls. See Files to include and Settings pages for more information.

Please note: Folders are searched recursively, so all sub-folders of the selected
locations will be processed unless certain sub-folders are explicitly excluded.

See 'Excluding Folders' in the 'Add Rules' section below for details.

Add multiple folders

It is possible to add multiple folders as a batch using the 'Add multiple folders...'
button on the Dashboard. Then either paste or type folder paths, one per line, into
the textbox provided. After they are added folders will appear in the folder list on the
Dashboard with default file types and settings profiles selected.

Add Rules

When a folder is added to the list for processing, by default all sub-folders of each
added folder will be processed by NXPowerLite in the same way. To exclude specific
sub-folders or set different Files to include and Settings to be used, click on the
parent folder then click the 'Add Rule...' button.

Excluding Folders
This feature is useful if you do not want certain areas of your data processed by
NXPowerLite. By excluding a folder, all files in this folder and all of its child folders
will not be considered for optimization.  Once a folder is excluded it will appear in the
list of locations with this icon  indicating all files inside will be skipped.

Changing settings for sub-folders
It is possible to change the File Types and Optimizations by selecting this radio button
in the dialog. This is a useful feature, if for instance, you have a parent folder where
all file types are considered for optimization, but have a specific sub-folder where
only PDF file should be optimized. In this case, you would:
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Select the parent folder in the list

Click 'Add Rule...' button

Choose the sub-folder you want to apply the settings on 

Enable the bottom radio button

Select or create a new File Types profile (where only PDF selected) from the drop-
down.

Click OK

Sub-folder rules will be added to the list with this icon  indicating there are
different rules to their parent folder.

Edit folders

To edit the settings or  path of a folder, select it and press the 'Edit...' button or
simply double-click the folder.

Alternatively use the 'Add Rule' option to customize settings for a specific sub-folder.

Network locations

As well as local drives and folders, shared network locations can also be added to the
list. For example, it is possible to optimize data on a shared SAN or NAS, providing
that it resides in the same Windows domain as the machine on which NXPowerLite is
installed. The NXPowerLite File Server service may also need to be configured with an
account that has full permissions to those locations. See Configuring the NXPowerLite
Service for more information.

Please note: When adding a location via a mapped network drive (e.g. N:), the
drive letter displayed in the folders list will be replaced with the equivalent UNC

path (e.g. \\server\share). This is because Windows manages drive mappings on a per-
user basis, and as such, they may not be available to the NXPowerLite service when it
needs to process files.

Moved or deleted folders

Folders that have previously been configured but have subsequently been moved or
deleted will appear "grayed out" in the list of locations. This is to indicate that the
folder no longer exists at the specified path.
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Remove

Selecting one or more folders in the folder list and clicking the "Remove" button will
remove the selected folders from the list. If an included folder has rules associated
with it, removing that folder will automatically remove all its rules.
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Files to include

Custom File Types Profiles

Supported File Types

NXPowerLite can optimize files with the following extensions:

Microsoft PowerPoint 97-2003 binary format (.ppt, .pot, .pps)

Microsoft PowerPoint 2007-2019 Open XML format (.pptx, .pptm, .potx, .potm, .ppsx,
.ppsm)

Microsoft Word 97-2003 binary format (.doc, .dot)

Microsoft Word 2007 - 2019 Open XML format (.docx, .docm, .dotx, .dotm)

Microsoft Excel 97-2003 binary format (.xls, .xlt)

Microsoft Excel 2007-2019 Open XML format (.xlsx, .xlsm, .xltx, .xltm)

PDF documents (.pdf)

JPEG images (.jpeg, .jpg, .jpe, .jfif, .jif, .jfi)

TIFF files (.tiff, .tif)

PNG files (.png)

To enable or disable individual file types expand the tree view and check or uncheck
the corresponding check-boxes.

Zip archives

By default NXPowerLite optimizes any of the selected file types that it finds inside Zip
archives. This behavior can be altered by using the check-box control.

Please note: NXPowerLite cannot optimize any file or Zip archive that is
encrypted or password protected

Read-only files

By default, files with the "read-only" attribute are not processed by NXPowerLite.
These files can be included by checking the "Include read-only files" checkbox.
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Limiting files by date

Typically, servers contain some files that users will access and edit regularly and other
files that are not actively in use, but may be consulted for reference purposes. To
reflect this, NXPowerLite can apply different settings in relation to when the file was
last modified (or accessed). 

Profile Name

Each profile has to be given a unique name, although you can use the same profile
name for another type of profile i.e. Settings profile or Schedule profile. We suggest
using a descriptive name to help explain what it does or a specific area to which it
should be applied. For example, you may want to call a particular profile 'All file types
except PDF' or 'Marketing area'.
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Settings

Settings

JPEG Quality

This sets the level of quality used by NXPowerLite when recompressing JPEG files.
Lower values will result in more disk space reclaimed, but will reduce the visual
quality of images. We recommended using our default settings because these offer an
excellent balance between space saving and quality

Resize images for display at:

Documents often contain very large images, taken with digital cameras for example,
which contain far more visual information than will ever be seen by a user in normal
use. NXPowerLite can scale these images down to target a particular display
resolution.

Allow JPEG conversion

If enabled NXPowerLite will convert images in other formats to JPEG if it makes them
smaller. 

PDF

Delete private application data

Applications that create PDFs files, such as Adobe Photoshop or Acrobat, are able to
store information within a PDF file that they can use when opening or editing the file.
This information can only be used by the application which created the file and is not
needed to display a PDF file. For most cases, we recommend deleting this data as it
will have no effect on the use of the PDF file.

Subset Embedded Fonts

Enabling this feature means only those characters that are actually used in the lay-out
are stored in the PDF. If the “$” character doesn’t appear anywhere in the text, that
character is not included in the font. This means that PDF files with subsetted fonts
are smaller than PDF files with embedded fonts.

Microsoft PowerPoint, Word & Excel
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Delete cropped areas of pictures

Enabling this feature will trim cropped images within documents so that only the
visible portion is stored in the file. This will reduce the size of the files, but users will
no longer be able to edit cropped images to reveal the areas that have been removed.

Flatten embedded objects

Enabling this feature will cause embedded documents within document files to be
'flattened', converting them into pictures. This will reduce the size of the files but
users will no longer be able to double-click embedded documents to edit them.

For example, a Word document might contain an embedded Excel sheet with a table
of figures. Double-clicking the table would normally open Excel to edit the figures, but
flattening the document converts the table to a simple picture, preventing this from
happening.

Reduce color depth of PNG images

When this feature is enabled NXPowerLite will reduce the number of colors used in
PNG images within Office files, where it is appropriate. This method is called
quantization and while it is a lossy process, compressed images look the same as the
originals. NXPowerLite uses the same approach for standalone PNG images.

Microsoft PowerPoint Only

Optimize images on slide masters

It is possible to select whether or not images that appear on slide masters will be
optimized. If this setting is enabled then all images in the PowerPoint will be
optimized. If it is disabled NXPowerLite will not process images that appear on slide
masters.

JPEG

Remove EXIF data

JPEG images normally include extra information (metadata) inside the file such as
the device on which the image was taken or location the image was taken plus many
more. By default NXPowerLite will retain this data however, this option enables this
data to be removed from each JPEG file.

Please note: There are currently no settings for PNG or TIFF files.
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Profile Name

Each profile has to be given a unique name, although you can use the same profile
name for another type of profile i.e. Files to include profile or Schedule profile. We
suggest using a descriptive name to help explain what it does or a specific area to
which it should be applied.
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Preferences

Run Mode

To switch between run modes select 'Preferences...' under the 'File' menu.

Single Pass

NXPowerLite will process all the files inside the configured folders and drives and then
stop and produce a report, needing to be manually restarted or re-configured. A detailed
report of NXPowerLite's progress through the Single Pass run is available in the 'Reports'
item 'Single Pass Reports'.

Loop Automatically

NXPowerLite will process all the files in the configured folders/drives and then
automatically re-start processing the same folders again. This means that subsequent
runs it is likely to process files that have been added since the original pass through the
folders/drives or files that were skipped due to configured age rules. This option enables
administrators to set the configuration once and ensure that NXPowerLite always
processes these folders/drives in the background.

Please note: If NXPowerLite does not find any data to optimize then it will
automatically pause for 24 hours before trying the same folders again.

Performance

Rescanning data is used to speed up compression by quicky skipping incompressible files.
Compression will be slower after clearing this data
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Scheduling

Custom schedule profiles

By default NXPowerLite will run without a schedule i.e. it will run without interruption
until either the job is complete (Evaluation mode) or the software pauses awaiting new
content (Optimize mode). However, because it may not be optimal to run NXPowerLite
at the same time as say a Backup tool, it may be desirable to set a custom schedule so
that NXPowerLite runs only during "quiet" periods. For example, you may want to run the
software in the evenings during the week and all day at weekends but start at a specific
future time and date.

Creating a custom schedule

You can create a custom schedule by selecting 'New profile...' option in the Schedule
drop-down control on the Dashboard. A schedule profile is made up of 1 or more time
slots. There are many repeat options and these options vary depending on the start date
and time selected.

Please note: NXPowerLite will automatically adjust the schedule according to
changes to the system clock, time zone or Daylight saving. 

Profile Name

Each profile has to be given a unique name, although you can use the same profile name
for another type of profile i.e. Settings profile or Files to include profile. We suggest
using a descriptive name to help explain what it does or a specific area to which it
should be applied. For example, you may want to call a particular profile 'Evenings &
weekends' or 'Marketing area'.
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Registration

Registration 

To enter your registration key, click the 'Register...' option under the 'Help' menu item.
Enter your registration key in the resulting window; the key will be validated when the
'OK' button is clicked. If the code is valid, the 'About NXPowerLite for File Servers'
window will appear showing the confirmed registration details.

Please note: Until NXPowerLite is registered using a registration key, it will
continue to run in Evaluation mode and will not reduce files.

What changes when I register?

Evaluation mode

Prior to registration NXPowerLite will be locked in 'Evaluation mode' and in this mode,
you will be able to point NXPowerLite at your server folders and produce a report of the
estimated space savings.  In this mode, NXPowerLite copies each file in turn to create a
temporary file and then optimizes it. It then deletes the temporary file, taking note of
the difference between the size of the original and optimized versions of the file. When
it has finished processing all of the candidate files, NXPowerLite generates a report
detailing the total expected space savings.

Please note: In Evaluation mode, the original file is never modified, deleted or
replaced.

Optimize mode

Once registered NXPowerLite for File Servers will be in optimize mode. This means that
the software will now replace files with smaller versions, reclaiming valuable disk
space.  A live report can be generated at any time showing the amount of disk
space reclaimed over time.

 NXPowerLite for File Servers Help

13 NXPowerLite for File Servers Help



Reports

Evaluation and Single Pass Reports

Results

This section shows the actual space savings you will achieve using the paid version of
NXPowerLite. During the scan NXPowerLite copies each file in turn to create a
temporary file and then optimizes it. It then deletes the temporary file, taking note of
the difference in size between the original and optimized versions.

Supported Files

This shows a breakdown of the supported file by file types.

Your Data

This section shows the amount of files in the selected folders that NXPowerLite can
process (Supported Files) and those that NXPowerLite cannot process. (Unsupported)

Supported Files Skipped

There are many reasons why supported files could be skipped. The table below details
these reasons one or more of which may appear on a report.

Skipped File
Reason

Explanation

Cannot
reduce with
current
Settings

The Settings selected cannot reduce these files. Amending the Settings may provide better
reduction performance, however, the quality of the processed files may be affected.

Configuration
Settings

These files have been skipped because the 'File Types' settings configured excluded them.
(See Files to include)

Not Old
Enough

Files have been skipped because they had been accessed or modified more recently than the
minimum threshold (See Files to include)

Offline Files that NXPowerLite did not process because they had the "offline" attribute set.

Read-Only Files that NXPowerLite did not process because they had the "read-only" attribute set.

Encrypted NXPowerLite cannot process Microsoft Office documents that are encrypted or password
protected. This is because there is currently no way to make the necessary passwords
and/or encryption keys available to NXPowerLite.

Already
Optimized

Files that have already been optimized by NXPowerLite.

JPEG too
small

JPEGs that NXPowerLite did not process because they were deemed too small.

Unknown
Error

Files that NXPowerLite failed to optimize for any other reason than those specified in this
table.
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Wrong
Extension or
corrupted file

Files with an extension that NXPowerLite expected to be able to process, but which are
actually of a different file type than is indicated by the file extension. One common
example is RTF (Rich Text Format) files with a ".doc" extension. Microsoft Word will open
such files without complaint, but NXPowerLite is unable to optimize RTF files.

File in use To avoid the possibility of data loss, NXPowerLite will not attempt to process files that are
in use (e.g. because a user has the file open for editing).

Created with
an old
version of
MSOffice (Pre
office 97)

Documents created by versions of Office pre-Office 97 will be skipped by NXPowerLite, and
the total size of such files will be counted in this category.

Could not
add tagging
data

NXPowerLite adds a small amount of data upon completion of successful reduction in size.
This ensures that when we encounter it again we can handle it appropriately. We failed to
add this data to files in this category and therefore skipped these files. 

Unparsable Files that are of an optimizable file type, but which NXPowerLite failed to process due to
encountering an unexpected condition while processing them.

Fast Saved
Microsoft
Word
Documents

NXPowerLite is currently unable to process Microsoft Word documents that have been saved
with the "Allow fast saves" option enabled. The "fast saves" feature has been disabled by
default since Word 2002 and has been removed entirely as of Word 2007.

PDF
Processing
error

NXPowerLite failed to process these PDF files, normally dues to the file being badly formed
or corrupt.

Deleted/
moved/
renamed

Files in this category are ones that have been deleted, moved or renamed since
NXPowerLite initially scanned them.

Internal error These are files that caused an error in the software when parsing them.

Non-
optimizable
PDF subset

NXPowerLite currently optimizes all known PDF subsets at time of release. It will not be
able to optimize subsequently released subsets and the files will be listed here.

Created by
an
unsupported
application

These are files that have been last saved by Office applications other than Microsoft Office.

Already
compressed
TIFF file

NXPowerLite cannot optimize TIFF files where one or more images are compressed.

TIFF file
contains
unsupported
tags

TIFF file(s) contain information that NXPowerLite does not recognise, so it has not processed
these files in order to protect the integrity of your data.

Unsupported Files

This table shows the top 15 plus consolidated 'other' file types that NXPowerLite did
not process. User settings have no affect on this table because NXPowerLite can only
process the following file types; PowerPoint, Word, Excel, JPEG, PDF, TIFF and Zip.

Inaccessible Folders

Folders listed in this category were selected to be included in the evaluation,
however, NXPowerLite was unable to access these folders. If the majority of your
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dataset is in this section please check that the 'NXPowerLite File Server Windows
service is configured with an account that has full permission
(Read/Write/Update/Delete) to these folders.

Live Report

The live optimize report shows an overview of what space has been reclaimed by
NXPowerLite. The report can be generated at any time once the software has been
registered and will always show up to date information. The report is split into three
main sections.

Data Reclaimed Summary

This section shows the total space reclaimed by NXPowerLite and breaks that down by
File Type.

Last 30 days

This is a summary of the last 30 days worth of progress by NXPowerLite. It details how
much disk space has been reclaimed each 24 hr period.

Previous Months

This table summarizes the amount of space reclaimed by NXPowerLite per month.
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Support
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System Requirements

System Requirements

NXPowerLite for File Servers can be run on any Microsoft Windows environment detailed
below:

Windows Server 2012

Windows Server 2012 R2

Windows Server 2016

Windows Server 2019  

Windows 8/8.1

Windows 10

All of the above with .NET framework V4.5.2 and above
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Configuring the NXPowerLite service

Configure Windows Service user account access permissions

NXPowerLite uses a windows service to manage and perform the optimization
processing. This service is configured with an account (LOCAL SYSTEM by default) to
enable optimization of data residing locally on most server configurations. However, if
you have a non-standard security model or you wish to optimize data that resides on
external devices, then the service may need to be configured with an account that has
FULL permissions (Read/Write/Update/Delete) to the following folders:

All the folders selected for optimization

The '%ALLUSERSPROFILE%\Neuxpower\NXPowerLite for File Servers v9' folder on the
installation server\machine

The TEMP folder of the local machine

Installation folder (usually:C:\Program Files (x86)\NXPowerLite for File Servers)

Registry hive:
Computer\HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\Neuxpower\NXPowerLite
Fileserver\9.0

Configure the service

Either

Open NXPowerLite for File Server Dashboard and choose the 'Configure Windows
Service...' option under the 'File' menu.

or

without starting NXPowerLite for File Servers:

Open services.msc

Double click "NXPowerLite File Server"

Switch to the "Log On" tab

Select the "This account:" radio button

Enter details of an account permissions as described above
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Click "OK"

Right-click on the NXPowerLite File Server service and select "Restart" from the menu

If you are configuring NXPowerLite to access a Novell NetWare installation via
eDirectory, please see 'login to eDirectory for a windows service' section in Technical
Support.
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Legal Notices

Copyright notices

Copyright © 2001-2021 Neuxpower Solutions Ltd

NXPowerLite is a trademark of Neuxpower Solutions Ltd.

Based in part of the work of the Independent JPEG Group.

Portions copyright 1984-2008 Adobe Systems, Inc. All rights reserved.

Portions copyright 1998-2010 Datalogics, Inc. All rights reserved. 

Portions copyright LibTIFF

Copyright (c) 1988-1997 Sam Leffler
Copyright (c) 1991-1997 Silicon Graphics, Inc.

Permission to use, copy, modify, distribute, and sell this software and
its documentation for any purpose is hereby granted without fee, provided
that (i) the above copyright notices and this permission notice appear in
all copies of the software and related documentation, and (ii) the names of
Sam Leffler and Silicon Graphics may not be used in any advertising or
publicity relating to the software without the specific, prior written
permission of Sam Leffler and Silicon Graphics.

THE SOFTWARE IS PROVIDED "AS-IS" AND WITHOUT WARRANTY OF ANY KIND,
EXPRESS, IMPLIED OR OTHERWISE, INCLUDING WITHOUT LIMITATION, ANY
WARRANTY OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE.

IN NO EVENT SHALL SAM LEFFLER OR SILICON GRAPHICS BE LIABLE FOR
ANY SPECIAL, INCIDENTAL, INDIRECT OR CONSEQUENTIAL DAMAGES OF ANY KIND,
OR ANY DAMAGES WHATSOEVER RESULTING FROM LOSS OF USE, DATA OR PROFITS,
WHETHER OR NOT ADVISED OF THE POSSIBILITY OF DAMAGE, AND ON ANY THEORY OF
LIABILITY, ARISING OUT OF OR IN CONNECTION WITH THE USE OR PERFORMANCE
OF THIS SOFTWARE.

Based in part on libzip by Dieter Baron and Thomas Klausner

Copyright © 1999-2021 Dieter Baron and Thomas Klausner

The authors can be contacted at <libzip@nih.at>

Redistribution and use in source and binary forms, with or without modification, are
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permitted provided that the following conditions are met:

1. Redistributions of source code must retain the above copyright notice, this list of
conditions and the following disclaimer.

2. Redistributions in binary form must reproduce the above copyright notice, this list
of conditions and the following disclaimer in the documentation and/or other
materials provided with the distribution.

3. The names of the authors may not be used to endorse or promote products derived
from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE AUTHORS ``AS IS'' AND ANY EXPRESS OR IMPLIED
WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO
EVENT SHALL THE AUTHORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL,
SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED
TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR
PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF
LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING
NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS
SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.
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